
 


 وادى ا���� ��
�– 

#�� "! ت و زاه� ا���� :  أ��اد – آ��
 ا�����
 وا�����$�� 

1

 ا	�رس ا�ول



� ه MatLab? 

  

 ��� ،����	
ه� أداة و���� ����� ������ ����� �����م ا�
 �. ا�-,�� �+ ا��*�() وا�'وال ا����%�� ا��$#�� دا"���  �!� �

 �	�8' آ��. ا���5د4ت ا����%�� وا�!2 �	�1 �1 ��!�) أ�0اع
��=%� � ��5'�' �+ . "�>� ��ا�;دوال و آ!���  �8: ��9 �����

 .ا����@ات ا?"�ى �.

 :ا�!���� ا����4ت �C!� MatLab+ اB!4��5ت ا�ـ

  Math and computation ا����%��ت و ا�
	�ب •
  Algorithm development ����� ا���ارز���ت •
• Data acquisition  
 Modeling, simulation, and � وا��
�آ�ة`�_#ا� •

prototyping  

��1 وا�d-!Bف و����� ا�$���0ت •� Data analysis, 

exploration, and visualization  
 Scientific and engineering ا���Bم ا��#'��B وا���0��$ •

graphics  
�#�ء وا`��ت اB!�'ام ر ����B���i�$�!ت  •

 Application development, including graphicalا��5'ة
user interface building  

ا��dآ� ا��#!��   ��klرا`MatLab k و���@�' �+ ا������5ت ��ل
 : ��#�mم

http://www.mathworks.com/ 

  

 :وا��� ا	�����

وا`�� اB4!��5ل  �Bف � ��m�q��9d� '#8 MatLab q �ـ
  :ا�!����
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 + �����8 �+ ا=�sرات�!-�ن ا��ا`�� �

  Command Window  إ�sر ا?وا�� .1

���m ا��
� �8:  ��� ،و�+ "y�x!� . إد"�ل ا?وا�� ����0�$;
1-d�آ!��� (>>) ا x!�9 و��ا?�� �5'{، و��� أن  MatLab  2ه

�#0 0
�1 �8: اB4!����  �ر ا04!��ء  Interpreted ��9 �~	�ة� 
� إ*��ر ا�#!��� �-1 أ�� ا�$���0;، و�-+ ��-+ ��# �+ آ!���

�s�i#� ��<�~� ��?ق ا�
��� ; 

 Workspace  إ�sر �#��i ا�1�5 .2
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 ��� �k��` ��m ا��!��9ات ا��	!���5  2 `�	� ا�1�5    
����
 .ا�

3. �i��	�ر ا?وا�� ا�sإ  Command History �8ض x!� ���
   2 `�	�ت k��` 1�8 ا?وا�� ا�!B 2$� إد"����

�i��B. 


��2إ�sر ا����' ا� .4  Current Directory 

 2 ه_ا ا=�sر �!x �8ض `��k ا���~�ت ا���`�دة  2 ���' 
���   C:MATLAB6p5work ا�
��2 وا�_ي �-�ن �8دة ا�1�5

����9d!� م�i#B 2!�$�ا�; ا�ا .� '`��. 

 (...) �ح?ي ���' �"� �+ "yل ا��~! ه_ا ا����' ��-+ �5'�1
?xB ا����'  2 أ�8: ا=�sر، أو �+ "yل 0~�  ا����ور

 (  2 ا���رة�i�#�5 رxl ) ا��~!�ح ا���`�د �8: ���� ا?دوات

 start  �� �$�. ��~!�ح ا���`�د أB~1 ا�Start ���d أ�� �~!�ح 
.�y" +� +-�� ��� ،م و�#'وز�m0 2   ا?دوات ��i� 1�9d�

���$� �i ا���ا MatLab. 

 �
���:  

  ��m� 'l  +8�q�' وا`�� اB4!��5ل ��!�~� ��5 ا�2dء
 2 ا���رة، أو l' ���� أ�0  2 إ"~�ء ��5 ا?�s أو  ا���5و%�

 undock `���5 "�رج ا��ا`��

� ا���`�د �8: ا���0��15 أي أ�sر "�ر`�� اB!1�5 �~!�ح 
  ا?��+ ا���5ي �+ ا=�sر، و=�8دة دا"1 ا��ا`�� أ"!�ر �+ ا=�sر

 View -> dock (window name) 

  و=�ly. اB!1�5 �~!�ح

ا�-,�� �+ ا������5ت ا��~�'ة  MatLab �� � ا����(� ا���ا �i �ـ 
 q#-� MatLab ا�$'ا ��B!�5ا%�� �+ "yل ا"!��رو� MatLab ��ل

Help ��)�l +� Help. 
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وأ�s وا`��  y" Matlabل ه_ا ا�'رس ��5 #� �8: ���� �����
 MatLab أوا�� اB4!�'ام،  2 ا�'رس ا�,��B 20ف 0!�5ف �8:

 .ا���>� ���!k� 1��5 ا��!���ت

 :ا	�رس ا	"�! 

  MatLabا	&�%��ت #  

  � ��Matlab����  !���ت��!2 ��15 إد"�ل ا��8 �+ ا?وا�� ا
وا�!1��5 ���5 أآ,� ��B��d� ��� ،$. ا?وا�� ا��	!���5  2 

MatLab�$��!���ت  2 ا��ب آ!��� ا��Bأ .  

�����5!Bف �0%� ه_{ ا?وا��، وآ�~�� ا�B 'رس�ل ه_ا اy".  

  

�

'(
:  

 أو ��!$� matrix laboratory ه2 ا"!��ر �5$�رة MatLabآ��� 
  :إ!��ء ا	&�%��ت .��~� �تا�

~�1 � ا��!��� 8#�>�ا�	� �i��s �!��5) ا��!��� ه2 �-!��� 
+����#� yآ  � �	رة ���
   ] [ �B�i+ ����5+ � و�

  

�4  أن 0!��� ا?�� ا�_ي l .!��!-� �#�l' *��ت �#� �$���ة `�ب 
 �s�i#� ��<�  .!���0 2  (%-+ أ�و ���	�0~� ا?�� ا;  
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  .ه_{ ا���ة ��m� 4 0!��� ا?�� �5'{

���l : آ�� ��-+ ���5) ا��!��� �+ "yل �
'�' ا����i ا?و�: 
  ا?"��ة ا����i: ا�@��دة

  

 �4  ا��!��9ات ا���� � �5��� Workspace 2 إ�sر �#��i ا�1�5 
   2 `�	� ا�1�5

  

   

  A و aآ�� ���d-1 أ��m� }y8 �!: ا¡ن �!���9+ ه�� 

MatLab�
 a �_ا  �ن ا��!Case-sensitive ��9�� ا?��ف  �	�س �
  .��A!�) ����� 8+ ا��!��9 

   

����
:  

 ��5ض ا��!��9 ا���` 2  � �5	� q#-��Whos آ!��� ا?�� 
  Command Windowا�1�5 ا�
����  2 إ�sر ا?وا�� 

   

  :-,ض ا	&�%��ت

 �9C0 x� .�!��ا xBم �-!��� ا�i0 .�!� ت أي���!
��5ض �
  Enterد"�ل �8: �~!�ح ا=
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  :أو ��-+ �8ض ا����i ا�,���0  2 ا��!�.  y" +� �iل ا?��

  

   

�!x  ���  2 آ1 ��ة . �4ans  ا��!��9 ا��'�' ا�_ي �x أ�d0ؤ{ 
آ!��� ا�� �#!; ���l .#8 �'ون ���5+ ه_{ ا����i إ�: �!��9  ¤ن 

  .q��ans ا��B ���iف �
�1  2 ا��!��9 

   

   

  : x�l ����!�.، أو ��5ض ا����i ا?و�: وا��ا�4�i  �5��5ض أول 

  

� �8: آ�~�� ا�!k� 1��5 ا��!���ت  2 ���� ا¡ن و�5' أن ��5 # 
MatLab ��� ع�`��� ����
 ، x!!�0 ا�'رس �
~  `�	� ا�1�5 ا�

�"� �l2 أي و   
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  :�12 وا�0,��ع �'.� ا	)&�


~  `�	� ا�1�5 �WorkSpace��)�l +� أ"!�ر  File - <Save 
workspace As   

  

 أ"!�ر ا �B�#� xB����` (	� Save Asو�+ "yل ���k ��ار 
y,� 1�5�ا :MyFirstMat  

ا���) �Bف �
~   2 ���' ا�1�5 وا�_ي �-�ن �8دة ���' 
C:MATLAB6p5work و��5: ا�4!'اد MAT  

  1�9d� '#8وMatLab �	�` (�� �5دة!Bة ����0 ��-+ ا�� 
 Mat ا"!�ر ا���) ذو ا�4!'اد  �File  - <Openxا�y" +� 1�5ل 

  .ا�_ي �~�m �. `�	� ا�1�5

 :ا�'رس ا�,��� 

2
#�ت # J&	ا MatLab  

 "yل ه_ا ا�'رس �Bف 0	!-�1 درا�B ا��@�' �+ أوا�� 
Matlab ��5� 1��5!�~� �ت وا���ء ا�d0�� �i�5!��وا.  
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2
#�ت إ!��ءJ&	ا: 

���l �i$� `'اً إ�: �i��s MatLab �s ���5) ا���~� �ت  2
  :���5) ا��!���ت، 0$'أ �$���ة �k أول �,�ل

>> D = [1 2 3; 4 5 6; 7 8 9] 

 

D = 

 

1 2 3 

4 5 6 

7 8 9 

 

  

�4  ا�~�ق ��+  �1 ا?8'اد ��	� � أو  �>�� �#�s�i، `�ب  
  :ا?��Bب آ_�q ه_ا

>> D = [ 1 2 3; 

4 5 6; 

7 8 9] 

 

D = 

 

1 2 3 

4 5 6 

7 8 9 

 

>>  

 :"�>� ال =�d0ء ��~� �تآ�� ��`' 8'د �+ ا�'و

  �d0= symmetricء ��~� � �!#�*�ة pascalدا��  .1
��~� �ت �!	�وى  ��� ����ع آ�d0=  1ء magic دا�� .2

  .ا��~�ف وا�84'ة
 .��~� � >~��� =�d0ء zeros دا�� .3
 1آ1 8#�>�ه� �	�وي  =�d0ء ��~� � ones دا�� .4

  �4  ا�4,�� ا�!����
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>> P = pascal(3) 

 

P = 

 

1 1 1 

1 2 3 

1 3 6 

 

>> M= magic(3) 

 

M = 

 

8 1 6 

3 5 7 

4 9 2 

 

>> z= zeros(2, 3) 

 

z = 

 

0 0 0 

0 0 0 

 

>> o = ones(2, 4) 

 

o = 

 

1 1 1 1 

1 1 1 1 

 

>>  

 K'- ��L�.M	)&'��ت ا	ت ا�#
2J&	ا: 

��15 ا�!k� 1��5 ا��!���ت  MatLab آ�� ذآ��i��B �0  �ن
  :�� ا�!����ا?�, وا���~� �ت أآ,� ��B��، `�ب

>> Sum = D + P 



 


 وادى ا���� ��
�– 

#�� "! ت و زاه� ا���� :  أ��اد – آ��
 ا�����
 وا�����$�� 

10

>> Sub = P - D 

>> D = D + 2 

>> P2 = P * 2 

>> Mult1 = P * D 

>> Mult2 = P .* D 

  

  

 Sum و�#!; 8#. ا���~� � D و k��� P آy �+: ا?�� ا?ول

 Sub  2 ا���~� � �s ;��0 D +� Pح: ا?�� ا�,�20

  D � �ا���~  إ�: آ�C�2�<�#8 +� ��#8 1) : ا?�� ا�,���

kا���8#. ��~� �: ا?�� ا ;!#� Mult1 ��0; %�ب ���  ~
 وا�!2 �
P 2  D  

ه_ا ا?��  (ا�#��y8 1$l ��i ا��Cب �4 ) :ا?�� ا�����
� �~�� .#8 ;!#�B Mult2 1<�� +8 !2 ه2 8$�رة�ب  وا�%

 D  2 ا�5#�� ا�� 1��i�P 2  . آ1 ��#8  2

    2 ا�#��;`�ب أ��C ا?���+ ا�!���+ و�4  ا�~�ق   

   

>> M 

 

M = 

 

8 1 6 

3 5 7 

4 9 2 

 

>> MM = M ^ 2 
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MM = 

 

91 67 67 

67 91 67 

67 67 91 

 

>> M2 = M .^ 2 

 

M2 = 

 

64 1 36 

9 25 49 

16 81 4 

 

>>  

  

M ^ 2 5#2 %�ب� ��	~� �  2 0~���ا 

M .^ 2 1. �5#2 %�ب آ	~� �  2 0~���8#��  2 ا. 

 �#
2J&	رة ا
M
     PQseTranspo%�د 

>> M' 

 

ans = 

 

8 3 4 

1 5 9 

6 7 2 

 �#
2J&	س ا
R(
     PQInverse%�د 

>> inv(M) 

 

ans = 

 

0.1472 -0.1444 0.0639 
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-0.0611 0.0222 0.1056 

-0.0194 0.1889 -0.1028 

 

>>  

 �#
2J&	ا T%� K'- ف,(�'	    

>> size(z) 

 

ans = 

 

2 3 
  

>> size(o) 

 

ans = 

 

2 4 

 

>>    

 :��'رس ا��ا��k,1 8'د ا?��B وا�,��0ا�5'د ا?ول �

 MatLab آ"�, ا	�Mود # 

  :أه'اف ا�'رس 

، وآ�~��  MatLab ا�!�5ف �8: آ�~�� ��,�1 آ,�� ا�
'ود  2
  .ا�!1��5 ���5

 

� �� Matlab ��#$��'وال ا�8'د �+ ا  k� 1��5!�1 ا��	!�دا"��� 
 !�,�x!�1 ��,���� آ�!�.، �, y� Polynomials ��� ، آ,�� ا�
'ود

 :ا�!���� ��5د�� آ,�� ا�
'ود
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  :�50ف ا��!�. ا�!��2

>> x = [1 3 -15 -2 9] 

 

x = 

 

1 3 -15 -2 9 

1�,�!� q�_آ   

>> Z = [1 0 0 0 -2] 

 

Z = 

 

1 0 0 0 -2  

 �&�W �X- ود�M	آ"�, ا �&�W .�ب�دة �M
: 

2 0
	� ���l آ,�� ا�
'ود ا?ول-� x ���l '#8 s=3  ،y,�
 polyval ��-+ اB!��5ل دا��

 

 (: ا�	$�� و�¤آ' �+ ا�#��;
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 : , ا	�MودإP%�د �Zور آ"�

��15 ا����i ا�-��� ����5د��  ا�!�i� s 2' ����_ور x�l ا��!��9
 �0	�وي 

 

[R(	وا: 

ا�'ا�� ه#�   �����5، �5#2 4آ!�dف ��5د�� آ,�� ا�
'ود ��_ور
 poly ه2

 

   

 :\,ب وW.&� آ"�, ا	�Mود

  conv��Cب ��5د�!�+ آ,�� �'ود  ���C5� 2 اB!��5ل دا��
 deconv و��i	�� ا�'ا��
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 :�i	�� آ,��ي �'ود  deconv +���!� ;!#� .0¤ 8#' اB!��5ل

 .ا�i	�� d ;��0 ولا? •
و 2 ا��,�ل ا�	��� آ�ن ا�$�2l�� ( 2l ا�i	�� r ا�,�20 •

 .(�+ ا�i	�� �!�. >~�ي

  ا?�8'ة  ��,1 8'د 
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 :ا�'رس ا�����


��2ة #  ,
 MatLab أوا

 و���l �~lة �+ ا?��ر ا����%�� ودوا��� ا�!2 �-��#�� ��#8  2 
�5!B@�' 8+ آ�~�� ا��ا x�5!#� ،�i��	�'روس ا�لا� matlab 

.� ��B�B?وا?وا�� ا.   

 

,

._ إ^�ر ا�وا: 

 l' ���0 �+ و�l ¡"�  2 �	� آ1 �� ه� ��`�د  أ�#�ء �#��8
  :��`'  +�!i��s�_�q. إ�sر ا?وا�� �8:

 Edit-> Clear  أ"!�ر إذا آ#� �+ �
$2 اB!��5ل ا�~¤رة .1
Command Window  

 �clc x أ�� إذا آ#� �~1C اB!��5ل ���� ا��~����  ¤آ!� .2
Enter.  

 ����
: 

x� 2!�!��9ات ا��ف ا_
�y" ��~��5ل  �	� إ�sر ا?وا�� �+ �
B!�' أن  Workspace `�	� ا�1�5، أ�s= �m0ر `�	� ا�1�5

 q#-�� Whos أ��C اB!��5ل ا?��. ا��!��9ات �x �!��9 أو �
_ف
ا�
���� ��!¤آ'، إذا آ�ن  ��5ض ا��!��9 ا���5 �  2 `�	� ا�1�5

 .�	� ا�1�5 ��� *�ه� �'�qإ�sر `

 :ا	)&� �Zف �&�` ا	&���,ات ا	&),#� #  �'.� 

+�!i��s �#�'� �Cوه#� أ�:  

 Edit - <Clear أ"!�ر  إذا آ#� �+ �
$2 اB!��5ل ا�~¤رة .1
Workspace 

 clear أ�� إذا آ#� �~1C اB!��5ل ���� ا��~����  ¤آ!� .2
x� Enter.   
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P�ت إ^�ر�M
 �-�a^ ,
 :ا�وا

!
  File -> Print ���ت إ�sر ا?وا�� آ���� ا"!�ر���8�$ �

 File -> Print و��$��8 ا��@ء ا��
'د  �i �+ ا=�sر أ"!�ر
selection  

 File -> Page و��!
-x  2 �#	�� ا����`�ت �+ ا��$��8 ا"!�ر
Setup ��m� ��� ار�� k��� q� page setup  +� +-�� _ي�ا

2  x-
 أس ا��~
��#	�� ا��~
� �,1 *��ر ر "y�. ا�!
Header ت���!
ه_ا ا��أس، *��ر أر�lم �»��B،  أو 4 و�
 .إ�#�ء ا��$��8 ا��	!fonts ���5 وا����ط

 

��ت ��

��2ة :  

• :�8 q��8 لy" matlab ا?��ف ���
 �_آ� أ0. �	�س �
case sensitive�  q�_� ،ن Clear 1,� �	�� clear 

  .B :�8$�1 ا��,�ل
 MatLab ��-+ أن �-!� أآ,� �+ أ�� ��B :�8 وا�'  2 •

�s�i#� ��<�~� ���#�� 1�~� ط أن��. 

>> A = [1 2 3 4 5]; B = [6 7 8 9 10]; 

>> C= A + B 
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C = 

 

7 9 11 13 15 

 

>>  

 ،+���~#� +���B :�8 'ا���إذا ) آ�� ��-+ آ!��� ا?�� ا �<�"
.� k	!� 4 ���d�ط ) آ�ن �8ض ا�i0 ثy� kC0 8#' (...) �¤ن

  .ا?ول ����0 ا�	��

>> D = [ 2 5 2 4 1 66 8 44 88 66 ... 

5 7 44 88 44 787 56 66 4] 

 

D = 

 

Columns 1 through 12  

 

2 5 2 4 1 66 8 44 88 66 5 7 

 

Columns 13 through 19  

 

44 88 44 787 56 66 4 

 

>>  

 �ن ا?وا�� ا�!2 �-!$��  2 أ�sر  y":�8 1  MatLabل ا��5 
وl' �	¤ل �� ا�~�('ة �+  History ا?وا�� �
~   �m �� 2 ا�ـ

 ه_ا؟

ا?وا��  ا�~�('ة �#. أq#-�� .0 إ�8دة اB!'�8ء إي �+ ه_{
ا�	���i و�#~�_ه� �+ `'�'، وذ�y" +� qل ا��9C ا��!-�ر �8: 

x�	�: ا?��  �~!�ح ا�»�8: �!: ��1 إ�_ي ���' �-�ار{، �ا
 .����0 وذ�q دون ا�
�`� إ�: إ�8دة آ!��!. ��ة


��ل �8: ا��	�8'ة ��ل أي أ�� أو دا��  2 •�� MatLab 
�x اxB ا?�� أو ا�'ا��  help �$���ة  2 إ�sر ا?وا�� أآ!�

���'ه� ��ل ذ�q ا��4،  و�Bف � ��m�q آ1 ا������5ت ا�!2
y,� ب�`  help sin 



 


 وادى ا���� ��
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 :ا��رس ا�0
دس 


%� # ا	,a MatLab 

  

ه�  MatLab آ�� ذآ��0  2 ا�'رس ا?ول �+ ه_{ ا�	�	��  �ن
��=%� � إ�:  ���� ����� ������ �
�ى ا�5'�' �+ ا�'وال ا���ه@ة،
�`�
"yل ه_ا . إ�-���0 آ!��� ��ا�; ودوال "�>� �#� �	� ا�

 .MatLab 0!�5ف �8: ا?وا�� ا�$����  2 ا�'رس �Bف

  if :ا	%&'� ا	�,^��

  �	!�'م �y"!��ر ��+ أ���+ �	� ��ط �
'د

 : ا����9 ا����5

if <condition>  

   <program1> 

else 

   <program2> 

end 


�i ا��dط� ��2 ��  condition -�د�ا _�~#� x!� 2  

program1 2  -�د�ا _�~#� x!� ط�d�ا �i
!� x� وإذا 

program2 

  :�,�ل

>> if n < 0 

  disp('n is negative') 

else 

  disp('n is positive') 

end 

n is positive 

>> n 
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n = 

 

71 

 

>>  

 �-y أآ,� �'ا"B�� y!��5ل أآ,� �+ if ��-+ أن �¤"_ `���
  elseif �	!�ي �ـ

if expression1 

  statements1 

elseif expression2 

  statements2 

else 

  statements3 

end 

 ا�1�5 2 ��� 0~�ا�! switch أو ��-+ اB!��5ل `���

�'&� switch  

  :ا����9 ا����5

switch switch_expr 

  case case_expr  

      statement,...,statement 

  case {case_expr1,case_expr2,case_expr3,...} 

      statement,...,statement 

  ... 

  otherwise 

      statement,...,statement 

End 

���:  

switch_expr  ��9!��!5$�� أو(ه� ا�ا"!$�ر ) ا x!�B _ي�ا
.!��l.  



 


 وادى ا���� ��
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case_expr !2 ��-+ أن�ا x�i�!����9-+ أن  أ�' ا��ه� ا_"¤�
���i�وإذا آ��0 ا ،���l +� �,ا�'ة أآ��ا ���
  ��ـ �!�C+ ا�

switch_expr 2  �`ر'� ��� x	i�� _�~#!�1 اi!#� ���� اي  
otherwise 

 �Pار,R�	ت ا�d'M	ا: 

��ات،  �ن أ 1C  8'ة) أو أآ,�( 2 �-�ار أ�� ��5+ #8'�� ���0 
 .�i��s �1�5 ذ�q ه� ��%k ه_ا ا?�� دا"�i�� 1 �-�ار��

2  MatLab +�8�0 '`�� !-�ار���ت ا�i�
 :  �i �+ ا�

1. �d'� for 

�+  و�	!�'م 8#'�� �-�ن ا�����ب ه� ا�!-�ار �5'د �
'د
 .ا���ات

  ا����9 ا����5

for variable = expression 

  statement 

  ... 

  statement 

end 

   ��ات� �i��4	��� �Bف �!-�ر : �,�ل

>> for j=1:4 
j 
end 
 
j = 
 
1 
 
 
j = 
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2 
 
 
j = 
 
3 
 
 
j = 
 
4 
 
>>  

 

2. �d'� while 

�x �5' ا��dط  ��� �-�ن ا�!-�ار ه#� ���$� �!
�i ��ط ��،  �ذا
�i�

�i �#!�2 ا�� 

  :ا����9 ا����5

while expression 

   statements  

end 

  

�-�ن �+  !n أول 8'د >
�� ��Cو�. ه_ا ا�$���0; ��`' :�,�ل
100�0�"  ���d8  

>> n = 1; 

while prod(1:n) < 1e100 

n = n + 1; 

end 

>> n 
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n = 

 

70 

  

 ����
: 

�9�  MatLab ة�	�9 �~�ه2  Interpreted 1أي أن آ  x!� أ��
اB!��5ل ا�
��iت ��`�!. ��
��Bب l$1 �#~�_{ �$���ة، �_ا  �ن 

��15 ا�$���0; أآ,� ��¤، و�~1C اB!��5ل ا4وا��  ا�!-�ار�� �Bف
 .آ��� أ�-+ ذ�MatLab q وا�'وال ا���ه@ة �ـ

:break   

وإ�8دة ا�!
-x  �	!�'م ه_ا ا?�� =��iف �#~�_ ���i �-�ار��
 .��$���0; أو ��
��i ا���ر`�� 8#' و`�د ���iت �!'ا"��

:continue 


��i��iم ه_ا ا?��2 ��
و�$'أ  l�� �� iteration  2) ا�!-�ار ا�
 .ا�!-�ار ا�!��2 �.

  

 

 

 

 

 


